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About this Manual 
The Oracle Financial Services Asset Liability Management Analytics (OFSALMA or ALMBI) 
application release 6.1.1.0.0 is based upon a dedicated reporting mart built from the new 
Fusion Financial Services Data Model. OFSALMA 6.1.1.0.0 leverages several components of 
Oracle Business Intelligence Enterprise Edition (OBIEE) technology including Dashboards 
and Answers. It also includes various Dashboards and Reports for the user to carryout 
various Asset and Liability based analytics. 

Audience 

This Manual is meant to be used by the Oracle Financial Services Analytical Applications 
Infrastructure (OFSAAI) System Administrator. This provides step-by-step instructions 
necessary for installing the OFSALMA release 6.1.1.0.0. 

Scope 

This manual provides a step-wise instruction to install the OFSALMA in an existing OFSAAI, 
hosted in Oracle 11g R2 (11.2.0.2.0) environment. 

Organization of the Manual 

The Installation Manual is organized into the following chapters. 

• Prerequisites section identifies the hardware and base software environment 
required for successful installation and functioning of OFSAAI. 

• Installing Oracle Financial Services Asset Liability Management Analytics 
6.1.1.0.0 section details the pre-installation activities followed by a step-by-step 
instruction on the various installation options. 

• Post Installation Activities section details the steps that are required to be 
performed after a successful installation of OFSAAI. 

Conventions Used in this Manual 

References to sections or chapters in the manual are displayed in Italics. 

Screen names are displayed in the following manner: 

Introduction screen 

Options and buttons are displayed in Bold. 

Notes are displayed as follows: 

NOTE 

o It is important that the password should be 6 characters long. If you do not 
adhere to this pre-requisite, you will see a system message that reads Password 
must be at least 6 characters long. 
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Prerequisites 
The installation process requires certain environmental variables to be set prior to starting the 
installation. You must ensure that these requirements are met before starting the installation. 
Refer to the Release Notes for the latest updates on hardware or software requirements and 
the OFSAAI Installation Manual for the environment variables. 

Environment 

Installation of OFSALMA release 6.1.1.0.0 requires OFSAAI v7.3.3.3.0, which is certified on 
Oracle 11g R2 (11.2.0.2.0) to be installed in either a single-tier or multi-tier environment. It is 
implicit that all base software versions and patch levels required by the RHEL/OEL-5.3/5.5 
version of OFSAAI 7.3.3.3.0 are available and adhered to. 

NOTE 

o The OFSALMA v6.1.1.0.0 installer download contains a primary ERwin XML file 

that is required for uploading the model. This file is sufficient to install the v6.1.1.0.0 

product. However, this XML file cannot be opened in ERwin Data modeler tool and 

hence cannot be used for any data model customization. This ERwin file is 

delivered as a patch and need to be downloaded separately. This ERwin file should 

be used for any customization of the data model. Reference bug / patch where the 

primary ERwin file can be downloaded is - 18535724 - OFS ASSET LIABILITY 
MANAGEMENT ANALYTICS 6.1.1.0.0 DATA MODEL. 

Prerequisites 

• Oracle Financial Services Analytical Applications Infrastructure version 7.3.3.3.0. 

• Oracle Business Intelligence Enterprise Edition version 11.1.1.7.0 on any supported 
operating system, once installed must be configured. 

• After Installation of OBIEE 11.1.1.7.0, following patch is recommended for all the 
customers who are using Oracle Business Intelligence Enterprise Edition 11.1.1.7.0, 
which can be downloaded from Oracle support site. 

• Patch - 16556157 

Front-End Access 

• Internet Explorer 8.0/9.0 

• Java Plug-in 1.6.0_21 

• Acrobat Reader 8.0 

• The screen resolutions supported are 1024*768 and 1280*1024 
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NOTE 

o Ensure that Java Plug-in is enabled from Browser Settings. 

 

If ALMBI 6.1.1.0.0 is being installed together with Oracle Financial Services Asset Liability 
Management application (OFSALM), then the ALMBI 6.1.1.0.0 installer expects the latest 
version of the OFSALM application (OFSALM 6.1.1.0.0) as a prerequisite. 
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Installing Oracle Financial Services Asset Liability 
Management Analytics 6.1.1.0.0 
Pre-Installation Activities 
The following is the Pre Installation checklist to ensure the readiness to start installing Oracle Financial 
Services Asset Liability Management Analytics Product: 

• Oracle Financial Services Analytical Applications Infrastructure v7.3.3.3.0 must be 
successfully installed. 

• If Infrastructure installation is on multi-tier environment, execute the following 
command in the DB Layer terminal  

• chmod -R 777 < ftpshare folder > 

• Navigate to ftpshare folder and set the umask shown as below, this is to ensure all 
the new files created have 666 file permissions assigned. 

• cd < ftpshare folder >  

• umask 0000 

• The Config and Atomic schema should be two distinct Oracle database users. 

• Provide required privileges for atomic schema by executing the file 
privileges_atomic_user.sql from DBA user. 

• Copy the entire OFSALMA v6.1.1.0.0 installer download directory to the server 
location (Including the DataModel directory). Also provide read, write, and execute 
permissions to all the files present in this directory. 

• Specify the log file path and name in the log4j.xml. Also update the “value” attribute 
as mentioned in the following figure. 

•  
Figure 1: Log4j.xml file configuration 

• Ensure that the paths mentioned in log4j.xml file have read, write, and execute 
permissions set. 

• Navigate to $FIC_HOME directory and execute the script 
config_table_privileges_for_atomic_user.sql in configuration schema. 

• Ensure that FICServer is up and running before proceeding for installation. 

Pre-Upgrade Activities 
This section is applicable only for the users who are upgrading OFSALMA from v6.1.0.0.0 to v.6.1.1.0.0 

Back-up of Database schema and Files 

• Back-up existing config and atomic schema of the information domain that is being 
upgraded. This can be used to restore the application, in case of any failures during 
upgrade. 

• Back-up FTPSHARE and $FIC_HOME folders of your existing environment. 
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T2T Changes 

The existing T2T's will be replaced during upgrade installation. Hence, take a backup of 
existing T2T's. 

T2T definitions are present in the following folders: 

• <FTPSHARE_PATH>/STAGE  

• <FTPSHARE_PATH>/<INFODOM>/erwin/sources  

Any customizations performed on the above mentioned T2T’s have to be replicated post 
upgrade. 

Datamodel Changes 

If data model is customized: 

1. Open both the models using ERwin Data Modeler tool. 

2. From Tools menu, select Complete Compare. 

3. In the Compare window, select your existing ALM_BI_Data_Model on left hand side. 

4. Select extracted ALMBI_Datamodel on right hand side. 

5. In Type Selection check Subject Area. 

6. Uncheck all except Auto Close Database/Script Models, in Advanced option. 

7. Click Compare. 

8. Resolve Differences screen by applying all the changes mentioned in the following 

spreadsheet for 6.1.0.0.0 to 6.1.1.0.0 upgrade. 

ALMBI_Datamodel_C
hanges_6.1.0.0.0-6.

 

The embedded file contains the following sheets: 

a. New Tables 

b. Dropped Tables 

c. Dropped Columns 

d. Added Columns 

e. Data Type Changes  

f. Null Option Changes 

g. PK Changes 

h. FK Changes 

i. Domain Changes 

9. Click Finish and Close. 

10. Save the file as XML in AllFusion Repository Format. For example, 

ALM_Datamodel.xml. 

11. Copy the modified existing into the location ftpshare/<INFODOM>/erwin/erwinXML. 

12. Perform Incremental/Sliced Model Upload in the Information domain where 

OFSALMA application is installed. 
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New Tables

		   		TABLE_NAME

				Dim_Account_Classification

				Dim_Acct_Portfolio

				Dim_Bands

				Dim_Bankruptcy_Chapter

				Dim_Loan_Recourse_Type

				Dim_Loss_Mitigation_Program

				Dim_Party

				Dim_Repurchase_Category





















Dropped Tables





Dropped Columns

		   		TABLE_NAME		COLUMN_NAME		COLUMN_DATATYPE		COLUMN_NULL_OPTION		COLUMN_IS_PK		COLUMN_IS_FK		DOMAIN_NAME

				Dim_Account		n_original_ltv		NUMBER(22,3)		NULL		No		No		Amount

				Dim_Financial_Element		financial_element_description		VARCHAR2(255)		NULL		No		No		String





Added Columns

		   		TABLE_NAME		COLUMN_NAME		COLUMN_DATATYPE		COLUMN_NULL_OPTION		COLUMN_IS_PK		COLUMN_IS_FK		DOMAIN_NAME

		1		Dim_Account		n_co_orig_ext_credit_score		NUMBER(5)		NULL		No		No		Score

		2		Dim_Account		n_co_orig_fico_score		NUMBER(5)		NULL		No		No		Score

		3		Dim_Account		n_orig_combined_ltv		NUMBER(22,3)		NULL		No		No		Amount

		4		Dim_Account		n_orig_external_credit_score		NUMBER(5)		NULL		No		No		Score

		5		Dim_Account		n_orig_fico_score		NUMBER(5)		NULL		No		No		Score

		6		Dim_Account		n_orig_ltv		NUMBER(22,3)		NULL		No		No		Amount

		7		Dim_Account		v_co_orig_ext_credit_score_src		VARCHAR2(40)		NULL		No		No		Description_Medium

		8		Dim_Account		v_commitment_contract_code		NUMBER(10)		NULL		No		No		SurrogateKey_Long

		9		Dim_Account		v_orig_ext_credit_score_source		VARCHAR2(40)		NULL		No		No		Description_Medium

		10		Dim_Acct_Status		v_acct_status_reg_display_cd		VARCHAR2(5)		NULL		No		No		Code_Alphanumeric_Short

		11		Dim_Attrition		v_attrition_reg_display_cd		VARCHAR2(5)		NULL		No		No		Code_Alphanumeric_Short

		12		Dim_Channel		v_channel_category_code		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		13		Dim_Channel		v_channel_category_desc		VARCHAR2(100)		NULL		No		No		Text_Long_Description

		14		Dim_Customer		v_beneficial_owner_category		VARCHAR2(50)		NULL		No		No		Code_Alphanumeric_Long_Type3

		15		Dim_Customer		v_data_origin		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		16		Dim_Financial_Element		description		VARCHAR2(255)		NULL		No		No		String

		17		Dim_Industry		v_naics_code		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		18		Dim_Industry		v_sic_code		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		19		Dim_Instrument_Contract		f_bespoke_derivative_ind		CHAR(1)		NULL		No		No		Flag

		20		Dim_Instrument_Contract		f_grandfathered_ind		CHAR(1)		NULL		No		No		Flag

		21		Dim_Instrument_Contract		f_on_the_run_flag		CHAR(1)		NULL		No		No		Flag

		22		Dim_Instrument_Contract		f_security_listed_ind		CHAR(1)		NULL		No		No		Flag

		23		Dim_Instrument_Contract		f_stepup_oth_incentive_redeem		CHAR(1)		NULL		No		No		Flag

		24		Dim_Instrument_Contract		f_subordinated_indicator		CHAR(1)		NULL		No		No		Flag

		25		Dim_Instrument_Contract		n_benchmark_tenor		NUMBER(22)		NULL		No		No		Number_Generic

		26		Dim_Instrument_Contract		n_modified_duration		NUMBER(8,4)		NULL		No		No		Number_Term

		27		Dim_Instrument_Contract		v_cd_credit_event_type		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		28		Dim_Instrument_Contract		v_cd_deliverable_type		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		29		Dim_Instrument_Contract		v_cd_redid		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		30		Dim_Instrument_Contract		v_cd_under_ref_type		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		31		Dim_Instrument_Contract		v_cic_code		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		32		Dim_Instrument_Contract		v_index_code		VARCHAR2(6)		NULL		No		No		Code_Alphanumeric_Short_Type2

		33		Dim_Instrument_Contract		v_isin_cd		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		34		Dim_Instrument_Contract		v_look_through_level_code		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		35		Dim_Instrument_Contract		v_opt_under_instru_type		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		36		Dim_Instrument_Contract		v_pre_conv_instr_code		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		37		Dim_Instrument_Contract		v_tranche_type		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		38		Dim_Lob		n_lob_id		NUMBER(14)		NULL		No		No		ID_NUMBER

		39		Dim_Management		v_mgr_supervisor_code		VARCHAR2(20)		NULL		No		No		Code_Alphanumeric_Long

		40		Dim_Org_Structure		d_merger_date		DATE		NULL		No		No		Date

		41		Dim_Org_Structure		f_financial_subsidiary_ind		CHAR(1)		NULL		No		No		Flag

		42		Dim_Org_Structure		f_merged_entity_ind		CHAR(1)		NULL		No		No		Flag

		43		Dim_Org_Structure		f_operating_entity		CHAR(1)		NULL		No		No		Flag

		44		Dim_Org_Structure		n_org_unit_id		NUMBER(14)		NULL		No		No		ID_NUMBER

		45		Dim_Org_Structure		v_occ_charter_id		VARCHAR2(20)		NULL		No		No		Identifier

		46		Dim_Product		n_interest_only_term		NUMBER(5)		NULL		No		No		Term

		47		Fct_Common_Account_Summary		d_foreclosure_completed		DATE		NULL		No		No		Date

		48		Fct_Common_Account_Summary		d_foreclosure_initiated		DATE		NULL		No		No		Date

		49		Fct_Common_Account_Summary		d_purchase_date		DATE		NULL		No		No		Date

		50		Fct_Common_Account_Summary		f_frozen_for_fraud_flag		CHAR(1)		NULL		No		No		Flag

		51		Fct_Common_Account_Summary		f_managed_account_flag		CHAR(1)		NULL		No		No		Flag

		52		Fct_Common_Account_Summary		f_planned_loan_tranf_ind		CHAR(1)		NULL		No		No		Flag

		53		Fct_Common_Account_Summary		n_bankruptcy_chapter_skey		NUMBER(3)		NULL		No		Yes		SurrogateKey_Short

		54		Fct_Common_Account_Summary		n_coll_reinvestment_mkt_value		NUMBER(22,3)		NULL		No		No		Amount

		55		Fct_Common_Account_Summary		n_crdt_score_rfresh_date_skey		NUMBER(10)		NULL		No		Yes		SurrogateKey_Long

		56		Fct_Common_Account_Summary		n_curr_combined_ltv		NUMBER(22,3)		NULL		No		No		Amount

		57		Fct_Common_Account_Summary		n_fico_score		NUMBER(5)		NULL		No		No		Score

		58		Fct_Common_Account_Summary		n_highest_dpd		NUMBER(22,3)		NULL		No		No		Amount

		59		Fct_Common_Account_Summary		n_indemnified_amount		NUMBER(22,3)		NULL		No		No		Amount

		60		Fct_Common_Account_Summary		n_indemnified_party_skey		NUMBER(10)		NULL		No		Yes		SurrogateKey_Long

		61		Fct_Common_Account_Summary		n_interest_reserve_amt		NUMBER(22,3)		NULL		No		No		Amount

		62		Fct_Common_Account_Summary		n_lease_residual_amount		NUMBER(22,3)		NULL		No		No		Amount

		63		Fct_Common_Account_Summary		n_loan_recourse_type_skey		NUMBER(10)		NULL		No		Yes		SurrogateKey_Long

		64		Fct_Common_Account_Summary		n_loan_vintage_skey		NUMBER(5)		NULL		No		Yes		SurrogateKey_Medium

		65		Fct_Common_Account_Summary		n_loss_mitigation_prg_skey		NUMBER(10)		NULL		No		Yes		SurrogateKey_Long

		66		Fct_Common_Account_Summary		n_realized_gain_loss_amt		NUMBER(22,3)		NULL		No		No		Amount

		67		Fct_Common_Account_Summary		n_realized_pnl_amt		NUMBER(22,3)		NULL		No		No		Amount

		68		Fct_Common_Account_Summary		n_referral_lob_skey		NUMBER(10)		NULL		No		Yes		SurrogateKey_Long

		69		Fct_Common_Account_Summary		n_repurchase_party_skey		NUMBER(10)		NULL		No		Yes		SurrogateKey_Long

		70		Fct_Common_Account_Summary		v_ext_credit_score_source		VARCHAR2(40)		NULL		No		No		Description_Medium

		71		Fct_Common_Account_Summary		v_indemnified_acct_number		VARCHAR2(25)		NULL		No		No		Code_AlphaNumeric





Data Type changes

		   		TABLE_NAME		COLUMN_NAME		NEW		NEW_DOMAIN		OLD		OLD_DOMAIN

		1		Dim_Data_Origin		v_data_source_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(15)		Code_Alphanumeric_Medium_Type2

		2		Dim_Lob		v_level10_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		3		Dim_Lob		v_level11_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		4		Dim_Lob		v_level12_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		5		Dim_Lob		v_level13_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		6		Dim_Lob		v_level14_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		7		Dim_Lob		v_level15_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		8		Dim_Lob		v_level16_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		9		Dim_Lob		v_level1_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		10		Dim_Lob		v_level2_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		11		Dim_Lob		v_level3_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		12		Dim_Lob		v_level4_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		13		Dim_Lob		v_level5_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		14		Dim_Lob		v_level6_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		15		Dim_Lob		v_level7_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		16		Dim_Lob		v_level8_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		17		Dim_Lob		v_level9_lob_code		VARCHAR2(20)		Code_Alphanumeric_Long		VARCHAR2(6)		Code_Alphanumeric_Short_Type2

		18		Dim_Lob		v_line_of_business_desc		VARCHAR2(255)		Description		VARCHAR2(60)		Text_Medium_Description

		19		Fct_Agg_Base_Ccy_Irr_Gap		n_run_skey		NUMBER(10)		Number		NUMBER(14)		Number

		20		Fct_Agg_Base_Ccy_Lr_Gap		n_run_skey		NUMBER(10)		ID_NUMBER		NUMBER(14)		ID_NUMBER

		21		Fct_Common_Account_Summary		n_account_classification_cd		NUMBER(5)		SurrogateKey_Medium		CHAR(18)		<default>

		22		Fct_Common_Account_Summary		n_acct_portfolio_skey		NUMBER(5)		SurrogateKey_Medium		CHAR(18)		<default>

		23		Fct_Common_Account_Summary		n_business_unit_skey		NUMBER(14)		ID_NUMBER		NUMBER(5)		SurrogateKey_Medium

		24		Fct_Common_Account_Summary		n_common_coa_skey		NUMBER(14)		ID_NUMBER		NUMBER(10)		SurrogateKey_Long

		25		Fct_Common_Account_Summary		n_delq_band_skey		NUMBER(5)		SurrogateKey_Medium		CHAR(18)		<default>

		26		Fct_Common_Account_Summary		n_gl_account_skey		NUMBER(14)		ID_NUMBER		NUMBER(10)		SurrogateKey_Long

		27		Fct_Common_Account_Summary		n_org_unit_skey		NUMBER(14)		ID_NUMBER		NUMBER(10)		SurrogateKey_Long

		28		Fct_Common_Account_Summary		n_repurchase_category_skey		NUMBER(5)		SurrogateKey_Medium		CHAR(18)		<default>





Null Option Changes

		   		TABLE_NAME		COLUMN_NAME		NEW		OLD





PK Changes





FK Changes

		   		TABLE_NAME		COLUMN_NAME		COLUMN_IS_FK_NEW		COLUMN_IS_FK_OLD

		1		Fct_Common_Account_Summary		n_account_classification_cd		Yes		No

		2		Fct_Common_Account_Summary		n_acct_portfolio_skey		Yes		No

		3		Fct_Common_Account_Summary		n_common_coa_skey		Yes		No

		4		Fct_Common_Account_Summary		n_delq_band_skey		Yes		No

		5		Fct_Common_Account_Summary		n_gl_account_skey		Yes		No

		6		Fct_Common_Account_Summary		n_org_unit_skey		Yes		No

		7		Fct_Common_Account_Summary		n_repurchase_category_skey		Yes		No





Domain Changes

		   		TABLE_NAME		COLUMN_NAME		DOMAIN_NAME_NEW		DOMAIN_NAME_OLD

		1		Dim_Data_Origin		v_data_source_code		Code_Alphanumeric_Long		Code_Alphanumeric_Medium_Type2

		2		Dim_Instrument_Contract		d_issue_date		DATE		Datetime

		3		Dim_Lob		v_level10_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		4		Dim_Lob		v_level11_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		5		Dim_Lob		v_level12_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		6		Dim_Lob		v_level13_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		7		Dim_Lob		v_level14_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		8		Dim_Lob		v_level15_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		9		Dim_Lob		v_level16_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		10		Dim_Lob		v_level1_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		11		Dim_Lob		v_level2_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		12		Dim_Lob		v_level3_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		13		Dim_Lob		v_level4_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		14		Dim_Lob		v_level5_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		15		Dim_Lob		v_level6_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		16		Dim_Lob		v_level7_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		17		Dim_Lob		v_level8_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		18		Dim_Lob		v_level9_lob_code		Code_Alphanumeric_Long		Code_Alphanumeric_Short_Type2

		19		Dim_Lob		v_line_of_business_desc		Description		Text_Medium_Description

		20		Fct_Common_Account_Summary		n_account_classification_cd		SurrogateKey_Medium		<default>

		21		Fct_Common_Account_Summary		n_acct_portfolio_skey		SurrogateKey_Medium		<default>

		22		Fct_Common_Account_Summary		n_business_unit_skey		ID_NUMBER		SurrogateKey_Medium

		23		Fct_Common_Account_Summary		n_common_coa_skey		ID_NUMBER		SurrogateKey_Long

		24		Fct_Common_Account_Summary		n_delq_band_skey		SurrogateKey_Medium		<default>

		25		Fct_Common_Account_Summary		n_gl_account_skey		ID_NUMBER		SurrogateKey_Long

		26		Fct_Common_Account_Summary		n_org_unit_skey		ID_NUMBER		SurrogateKey_Long

		27		Fct_Common_Account_Summary		n_repurchase_category_skey		SurrogateKey_Medium		<default>
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Incremental/Sliced model upload might give errors if NOT NULL columns are added to a table 
that already has rows or if the columns that are being dropped have values. Check the data 
model changes excel file for any such cases. In such a case, take a backup of the table and 
truncate the table. Insert records back into the table with a default value for the NOT NULL 
column. 

Use Cases: 

If OFSALMA 6.1.1.0.0 is installed in a version of Oracle Financial Services Data Foundation 
(OFSDF) between 7.4.0.0.0 and 7.4.2.0.0, then: 

Case 1: 

• Manually execute the below pre model script file 'pre_model_ddl_ALMBI_611.sql' 
prior to a standalone upgrade installation from OFSALMA 6.1.0.0.0 to OFSALMA 

6.1.1.0.0.
pre_model_ddl_ALMBI_611.sql

 

• Manually execute the pre model script file 'pre_model_ddl_ALM_611_ALMBI_611.sql' 
prior to an integrated (ALM+ALMBI) upgrade installation from 6.1.0.0.0 to 

6.1.1.0.0.
pre_model_ddl_ALM_611_ALMBI_611.sql

 

Case 2: 

• Exclude the SQL statements related to DIM_FINANCIAL_ELEMENT table from the 
above pre-model scripts before manual execution. 

Follow the instructions mentioned in the “Merging Data Model Changes into Existing 
Model.doc” for merging the existing data model with 6.1.1.0.0 OFSALMA data model. 

If data model is not customized: 

1. Copy the extracted ALMBI_Datamodel.xml into the location 
ftpshare/<INFODOM>/erwin/erwinXML. 

2. Perform Incremental/Sliced Model Upload in the Information domain where 
OFSALMA application is installed. 

 
If RPD and Web catalog files are customized: 
 
1. In case certain customization was done to RPD and Web catalog files, backup 

RPD and Web catalog files. You may redo the customization after the installation 
is completed. 
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CREATE TABLE DIM_FINANCIAL_ELEMENT_B611 AS SELECT * FROM DIM_FINANCIAL_ELEMENT

/

UPDATE DIM_FINANCIAL_ELEMENT SET FINANCIAL_ELEMENT_DESCRIPTION=NULL

/

create table Fct_Agg_Base_Ccy_Irr_Gap_B611 as select * From Fct_Agg_Base_Ccy_Irr_Gap

/

truncate table Fct_Agg_Base_Ccy_Irr_Gap

/

create table Fct_Agg_Base_Ccy_Lr_Gap_B611 as select * From Fct_Agg_Base_Ccy_Lr_Gap

/

truncate table Fct_Agg_Base_Ccy_Lr_Gap

/

create table FCT_COMMON_ACCOUNT_SUMMARY_611 as select * From FCT_COMMON_ACCOUNT_SUMMARY

/

update FCT_COMMON_ACCOUNT_SUMMARY set n_account_classification_cd = NULL

/

update FCT_COMMON_ACCOUNT_SUMMARY set n_acct_portfolio_skey = NULL

/

update FCT_COMMON_ACCOUNT_SUMMARY set n_delq_band_skey = NULL

/

update FCT_COMMON_ACCOUNT_SUMMARY set n_repurchase_category_skey = NULL

/

COMMIT

/
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CREATE TABLE DIM_FINANCIAL_ELEMENT_B611 AS SELECT * FROM DIM_FINANCIAL_ELEMENT

/

UPDATE DIM_FINANCIAL_ELEMENT SET FINANCIAL_ELEMENT_DESCRIPTION=NULL

/

create table Fct_Agg_Base_Ccy_Irr_Gap_B611 as select * From Fct_Agg_Base_Ccy_Irr_Gap

/

truncate table Fct_Agg_Base_Ccy_Irr_Gap

/

create table Fct_Agg_Base_Ccy_Lr_Gap_B611 as select * From Fct_Agg_Base_Ccy_Lr_Gap

/

truncate table Fct_Agg_Base_Ccy_Lr_Gap

/

create table FCT_COMMON_ACCOUNT_SUMMARY_611 as select * From FCT_COMMON_ACCOUNT_SUMMARY

/

update FCT_COMMON_ACCOUNT_SUMMARY set n_account_classification_cd = NULL

/

update FCT_COMMON_ACCOUNT_SUMMARY set n_acct_portfolio_skey = NULL

/

update FCT_COMMON_ACCOUNT_SUMMARY set n_delq_band_skey = NULL

/

update FCT_COMMON_ACCOUNT_SUMMARY set n_repurchase_category_skey = NULL

/

COMMIT

/
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Oracle Financial Services Asset Liability 
Management Analytics v6.1.1.0.0 Product 
Installation 
The Oracle Financial Services Analytical Applications Infrastructure Product comprises of 
components that are installed in Web, Application, and Database layer. Hence if you have 
installed OFSAAI 7.3.3.3.0 in a multi-tier architecture, the OFSALMA product installer must be 
invoked on each of the machines that host OFSAAI tiers. 

For a Single-tier installation, the installer is required to be invoked only once on the machine 
that hosts all the OFSAAI tiers. 

This section describes the installation process where the three product setup components are 
installed on separate machines in with the product installation on separate machines. 
Machine A is used to install product Application Layer components, Machine B is used to 
install product Database Layer components and Machine C is used to install product Web 
Layer components.  

NOTE 

• This section is applicable only if OFSAAI v7.3.3.3.0 has been installed separate 
machines A and B respectively. 

• Refer to section on Silent Installation, if you wish to install the application in silent 
mode. 
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Machine A – Product App Layer 

Step 1 

To begin Oracle Financial Services Asset Liability Management Analytics product installation, 
execute the file Setup.sh. 

 

 

Figure 2: Installation Splash Screen 

Step 2 

 

 

Figure 3: Introduction Screen 

Upon invoking the installer, the Introduction screen is displayed with the prerequisites for 
installation. Ensure that all the prerequisites are met before you proceed with the installation. 
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Step 3 

Choose the log mode for this installer. If Debug is selected, the Passwords will be printed in 
the log file. 

 

Figure 4: Log Mode Option Screen 

Step 4 

Provide the 9 digit Customer Identification Number provided during the OFSAAI installation. 

 
Figure 5: Customer ID Input Screen 

Click Next to continue.
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Step 5 

The Pre Setup Information screen requests for setup information. 

Select the appropriate OFSAAI layer that has been installed on the machine. 

For example, Application Layer 

 
Figure 6: Pre Setup Information Screen – Choose Layer to Install 

NOTE 

o For a single-tier OFSAAI installation, you must select App Layer, DB Layer For a 
multi-tier OFSAAI installation, select the corresponding layer installed on the 
machine. 
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Step 6 

This window seeks information on whether a new infodom has to be created or the existing 
infodom to be used for apps installation. Select the desired option. 

 

Figure 7: Pre Setup Information Screen – Infodom type 

Click Next to continue. 

Step 7-i 

If the option New Infodom was chosen in the previous window, then the following window 
with create Information Domain details. 

Specify a DB name for the new infodom. Make a TNS entry with the DB name specified in the 
tnsname.ora file in the oracle server. 

Enter the newly created atomic schema user name, password, and jdbc URL in relevant 
fields. 

Click Next to continue. 
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Figure 8: Database details for the new Infodom 

 

Step 7-ii 

If the option New Infodom was chosen in the previous panel then the following panel will be 
displayed following the panel 7-i which will seek further information of the following details to 
create infodom. 

Specify the name and description for the new infodom to be created.  

Specify a segment name to be created. 

Note : Infodom and Segment name should not exceed 10 Characters. 

Also specify the Application server and database server log path for infodom maintenance (to 
be created). 
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Figure 9: Infodom details for creation of new Infodom 

NOTE: 

o The OFSAAI user must have a role that is able to perform Add/Modify 
functions in OFSALMA metadata. 

Click Next to continue.  

 

Step 7-iii 

If the option New Infodom was chosen in the previous panel then the following panel will be 
displayed following the panel 7-ii which will display the pre-infodom creation details. Check 
and verify all the details before proceeding to the next step. 
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Figure 10: Pre Infodom Creation Summary 

 

Click Next to continue creation of information domain. The new information domain is 
created. 

Step 7-iv 

If the option Existing Infodom was chosen in the Step 6 then the following panel will be 
displayed which will prompt to select the infodom from list of infodoms present in the setup, 
enter segment code and enter the application schema’s TNS name. 

Note : 

o Segment name should not exceed 10 Characters. 
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                                                                  Figure 11: Installation in Progress 

Step 8 

OFSALMA v6.1.1.0.0 data model is packaged as part of OFSALMA v6.1.1.0.0 product 
installer and will be installed as part of the upcoming steps, if required. 

The following screen prompts the user to opt for model upload process through installer. 

 

 

Figure 12: Pre-Setup Information 

Click No if you have uploaded the OFSALMA v6.1.1.0.0 model into information domain prior 
to this installation. 
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Click Yes to proceed with the OFSALMA v6.1.1.0.0 model upload process as part of the 
installation. 

If the user selects “Yes”, Step 9 and 10 will be performed. 

Upon selecting “No”, Step 9 to 10 will be skipped. 

Click Next to proceed. 

 

Step 9 

This step is applicable only if you are performing the model upload process as part of the 
solution installation. The following panel prompts the user to choose whether the released 
version of Datamodel or the customized datamodel to be uploaded. 

On selecting Released Data Model option, installer uploads the OFSALMA v6.1.1.0.0 data 
model that is packaged as part of the OFSALMA v6.1.1.0.0 product. 

On selecting Customized Data Model option, installer allows the user to select the data 
model. 

Click Next to proceed. 

 
Figure 13: Pre – Setup information 

Step 10 

If the option Customized Data Model was chosen, the following panel is displayed prompting 
user to select the customized data model located in the machine. 

Please choose the customized datamodel file from the server. 

Note:  

• The data model xml file should be available in the server. 
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• In case the installation is being performed on an existing information domain, the data 
model that is planned to be selected in this panel should be merged with the data 
model that was previously uploaded in the information domain. 

In case the installation is being performed on a new information domain, data model that is 
either customized or merged with other data models can be selected in this panel. 

 

 
Figure 14: Pre – Setup information 

Step 11 

The following panel displays pre-model upload details. 

Verify the details before proceeding to the next step. 

Click Next to proceed for model upload. 
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Figure 15: Pre – Model Upload Summary 

Click Next to start the model upload process. This process will take some time depending on 
the size of the data model and available physical memory in the environment. You will not be 
able to take any further action on the screen, until the model upload is complete. Note that 
this process cannot be rolled back. 

If the model upload fails, then a pop-up message with relevant error and the log file path is 
displayed. 

Review errors and take relevant action. Continue with this step until the model upload is 
successful and the installer takes you to next step. 

Few common errors during model upload are: 

• Insufficient heap memory on the client machine. 

• Possible reason/resolution: The java memory settings in “reveleusstartup.sh” located 
in $FIC_APP_HOME/common/FICServer/bin directory should be increased. 

• Error while getting the Erwin File path. 

• Possible reason/resolution: Restart the FICServer. 

• Error in Upload Operation: “FAILED WHILE SUPER CATEGORY - SUB CATEGORY 
RELATIONS HANDLINGDELETING”. 

• Possible reason/resolution: Incorrect Erwin.xsl file version in 
$FIC_APP_HOME/common/FICServer/conf directory. 

•  

NOTE: 

• Incremental/Sliced model upload might give errors if there are NOT NULL columns 
being added to a table that already has rows or if the columns that are being dropped 
have values. Check the data model changes excel file for any such cases. In such a 
case, take a backup of the table and truncate the table. Insert records back into the 
table with a default value for the NOT NULL column. 
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• Navigate to the previous screen and proceed with the steps mentioned above. 

 

Step 12 

The following panel seeks input from the user on whether to create new ETL 
application/source pair or use an existing one. 

In case of upgrade, if customer selects an existing application/source pair, then existing ETL 
definitions under the source will be over-written with the packaged definitions. Customer can 
also choose to create a new application / source pair and then merge the changes between 
the packaged definition and their existing definitions offline. 

Please choose a desired option. 

Click Next to continue 

 

 
Figure 16: Pre – Setup Information 

Step 13-i 

If the option New application/source pair was chosen then the following panel is displayed 
seeking the application and source name for creation of the same. 

Please specify all the details required for application and source creation. 

Click Next to proceed. 

Clicking ‘Next’ will create application and source within OFSAAI. Source model will also be 
generated. This process will take some time depending on the number of entities / attributes 
in the atomic schema. This step cannot be rolled back. 
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Figure 17: Pre – Setup Information 

Note:  

• ETL Source will be created pointing to the information domain (atomic schema) that is 
specified during the installation. 

 

Step 13-ii 

If the option “Existing application/source pair” was chosen the following panel will be 
displayed prompting user to select app/source pair from the list of pairs already present. 

Please choose the desired ETL application/source pair into which ETL definitions will be 
deployed. 

Click Next to proceed 
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Figure 18: Pre – Setup Information 

Step 14 

The following panel seeks input from the user on the OFSAAI user id to be used for 
installation. 

Specify the OFSAAI user ID in Uppercase 

 
Figure 19: Pre – Setup Information 

 

Click Next to proceed 
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Step 15 

This panel displays all the pre-installation summary. Please verify all details and proceed. 

Click Install to proceed. 

 

 
Figure 20: Pre – Install Summary 

Step 16 

This panel displays the installation process. Please wait until it completes. 

 
Figure 21: Installation is in progress 
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Step 17 

The following screen displays the completion of installation of the Oracle Financial Services 
Asset Liability Management Analytics Product Setup. 

Click Done to exit. 

 
Figure 22: Installation Complete 
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Machine B – Product Database Layer 

Step 1 

To begin OFSALMA product installation, execute Setup.sh. 

 

Figure 23: Installation Splash Screen 

Step 2 

 

 

Figure 24: Introduction Screen  

 

Upon invoking the installer, the Introduction screen will display the pre-requisites for 
installation. Ensure that the pre-requisites are satisfied before you proceed. 
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Step 3 

Please choose the log mode for this installer. In case, if Debug is selected, the Passwords will 
be printed in the Log File. 

Click Next to proceed. 

 

Figure 25: Log Mode Option Screen 

Step 4 

Please provide the 9 digit Customer Identification number provided during the OFSAAI 
installation.  
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Figure 26: Customer ID Input Screen 

Click Next to continue.
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Step 5 

The Pre Setup Information screen requests for setup information. 

Select the appropriate OFSAAI layer that has been installed on the machine. For example, 
Database Layer. 

 

 
Figure 27: Pre Setup Information Screen – Choose Layer to Install 

NOTE 

o For a single-tier OFSAAI installation, you must select App Layer, DB Layer For a 
multi-tier OFSAAI installation, select the corresponding layer installed on the 
machine. 

Step 6 

The following panel will be displayed which will prompt to select the infodom from list of 
infodoms present in the setup, enter segment code and enter the application schema’s TNS 
name. 

NOTE: 

o Segment code should not exceed 10 characters. 
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Figure 28: Pre Setup Information Screen 

Step 7 

The following panel seeks input from the user on the OFSAAI user id to be used for 
installation. 

Specify the OFSAAI user ID 

 
Figure 29: Pre – Setup Information 
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Click Next to proceed 

Step 8 

This panel displays all the pre-installation summary. Verify all details and proceed. 

Click Install to proceed. 

 
Figure 30: Pre – Install Summary 

Step 9 

This panel displays the installation process. 

 
Figure 31: Installation is in progress 
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Step 10 

The following screen displays the completion of installation of the OFSALMA setup. 

Click Done to exit. 

 
Figure 32: Installation Complete 
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Silent Installation  
Silent installation is achieved via a properties file [Silent.props] that must be updated with 
proper values, before attempting to install using the silent mode. 

How to Install ALMBI in Silent Mode 

To install ALMBI in Silent Mode, follow the below steps: 

1. Create a copy of the Silent.template file present in the installation folder and 
rename the copy as Silent.props. 

2. Edit the file Silent.props and specify the parameters as per the requirements. 

3. On the UNIX Command prompt, execute the following command: 

Setup.sh SILENT 

4. Refer to the console log [or the file preinstall.log] for any error messages. 

The following table lists all the properties that need to be specified: 

 

Property Name Description of 
Property 

Permissible 
values  

Comments 

LOG_MODE Mode for logging 0 = Debug  
1= General 

Optional; 
Default : 0 

CUSTOMER_ID Customer id 
specified while 
installing OFSAAI 

Not Applicable MANDATORY 

INSTALL_APP Install Application-
tier components be 
installed 

0 = No 
1 = Yes 

Default : 0 

INSTALL_DB Install database-tier 
components 

0 = No 
1 = Yes 

Default : 0 

OFSAAI_USER_ID Provide OFSAAI 
User ID 

Not Applicable MANDATORY 

INFODOM_NAME Information 
Domain(infodom) 

Not Applicable MANDATORY 

SEGMENT_CODE Segment Code Not Applicable MANDATORY 

Segment Code should not 
exceed 10 characters 

INFODOM_TYPE New Infodom or 
Existing Infodom 

0 = New 
1 = Existing 

# Specify Infodom Type 

Mandatory if this an App Layer 
Installation and option selected 
for INSTALL_APP=1 
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APPL_TNS TNS Name of the 
Infodom database 

Not Applicable MANDATORY 

APPL_USER User-id of the 
Database Schema for 
new Infodom 

Not Applicable # Mandatory if this an App 
Layer Installation and want to 
create a new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APPL_PWD Password  of the 
Database Schema for 
new Infodom 

Not Applicable # Mandatory if this an App 
Layer Installation and want to 
create a new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APPL_URL JDBC Connection 
String of the 
Database Schema for 
new Infodom 

Not Applicable # Mandatory if this an App 
Layer Installation and want to 
create a new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

RAC_STATUS Whether the 
Database Schema for 
new Infodom is a 
RAC database 

Not Applicable # Mandatory if this an App 
Layer Installation and want to 
create a new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

INFODOM_DESC Description for the 
Database Schema for 
new Infodom 

Not Applicable # Mandatory if this an App 
Layer Installation and want to 
create a new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

 

APPFTP_LOG_PA
TH 

Infodom Maintenance 
log path (to be 
created) for the new 
Infodom for app 
layer. 

Not Applicable # Mandatory if this an App 
Layer Installation and want to 
create a new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 
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DBFTP_LOG_PAT
H 

Infodom Maintenance 
log path (to be 
created) for the new 
Infodom for DBLayer. 

Not Applicable # Mandatory if this an App 
Layer Installation and want to 
create a new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

UPLOAD_MODEL whether you want to 
perform Model 
Upload 

0 = No 
1 = yes 

Mandatory if 
INSTALL_APP=1 

MODEL_TYPE Released datamodel 
or Customized 
datamodel 

0 = released 
1 = 
customized 

Mandatory if 
INSTALL_APP=1 

DATAMODEL the path for the 
customized 
datamodel 

Not Applicable # Mandatory only in the case  
of uploading the customized 
datamodel 

# Option selected for 
MODEL_TYPE=1 

DM_DIRECTORY the file name for the 
customized 
datamodel 

Not Applicable # Mandatory only in the case  
of uploading the customized 
datamodel 

# Option selected for 
MODEL_TYPE=1 

ETL_APPSRC_TY
PE 

Create new ETL 
App/Src pair or use 
an existing one 

0 = New 
1 = Existing 

# Mandatory if this an App 
Layer installation 

# Option selected for 
INSTALL_APP=1 

# 0 = If you want to create a 
new ETL app/src pair 

# 1 = If you want to use an 
existing pair 

ETL_APP_1_DES
C 

Please give 
description for the 
ETL App 

Not Applicable # Mandatory if you want to 
create new ETL app/src pair 

# Option selected for 
ETL_APPSRC_TYPE=0 

ETL_SRC_1_1_DE
SC 

Please give 
description for the 
ETL Src 

Not Applicable # Mandatory if you want to 
create new ETL app/src pair 

# Option selected for 
ETL_APPSRC_TYPE=0 
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ETL_APP_1_NAM
E 

 

The ETL application 
name 

Not Applicable # Mandatory if this an App 
Layer installation 

# Option selected for 
INSTALL_APP=1 

ETL_SRC_1_1_NA
ME 

 

The ETL Source into 
which the Table-2-
Table ETL definitions 
on staging tables will 
be deployed. 

Not Applicable This Source must be mapped 
to the above ETL Application 
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Post Installation Activities 
Oracle Financial Services Analytical Applications Infrastructure Server Memory 
Configuration 

The Oracle Financial Services Analytical Applications Infrastructure Application Server is 
started using reveleusstartup.sh file. This file can be edited for customizing memory settings 
and garbage collector settings depending on the available hardware configuration. Raise a 
Service Request (SR) via support.oracle.com if you have any queries related to EPM 
applications. 

Once the installation of OFSALMA is completed, you must perform the following steps. 

• Check the Log file (The path and file name specified in the log4j.xml). You can ignore 
the following errors in the log file: 

• Error: ORA-02260: table can have only one primary key. 

• Error: ORA-00955: name is already used by an existing object. 

• Error: ORA-00001: unique constraint (<<UNIQUE KEY NAME>>) violated.  

• Error: ORA-02275: such a referential constraint already exists in the table. 

• Error: ORA-01430: column being added already exists in table. 

• Error: ORA-02303: cannot drop or replace a type with type or table dependents 

• This post-installation step is applicable for upgrade from v6.1.0.0.0. 

• A few tables are truncated as part of pre-installation activities. The customer can 
restore the data into these tables from the corresponding backup tables. 

• The following are the back up tables created: 

• Fct_Agg_Base_Ccy_Irr_Gap_B611 

• dim_financial_element_b611 

• Fct_Agg_Base_Ccy_Lr_Gap_B611 

• FCT_COMMON_ACCOUNT_SUMMARY_611 

• Insert records back into the truncated tables from the backup tables mentioned in the 
pre model script files. 

• Execute the post model script file ‘post_model_ins_ALMBI_611.sql’ only for valid 
case Case 1 as mentioned in the Pre-Upgrade Activities section. 

• If you are installing OFSALMA on OFSAAI 7.3.3.0.0 or higher versions, you need to 
run the Multiple Language Support (MLS) utility. For more information, refer to 
Multiple Language Support (MLS) Utility section in OFSAAI Administration Guide in 
OTN. 

•  
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Oracle Financial Services Asset Liability Management 
Analytics Configuration 

1. Make sure Oracle Business Intelligence (Version 11.1.1.7.0) installation is completed 
with the patch 16556157 and is available. 

2. Set the <Oracle BI Instance Home> directory. 
For example, /u01/OBIEE11G/instances/instance1. 

3. Start Weblogic AdminServer. 
a. Set the < BI Domain Home> directory.  

For Example, /u01/OBIEE11G/user_projects/domains/bifoundation_domain. 
b. Navigate to < BI Domain Home >/bin and run nohup ./startWebLogic.sh &. 
c. Bringing up this service may take a few minutes depending on your 

environment. Check the logs using the command tail –f nohup.out. 
4. Start Node Manager. 

a. Set the < WebLogic Server Home > directory>. 
For example, /u01/OBIEE11G/wlserver_10.3. 

b. Navigate to <WebLogic Server Home>/server/bin and execute the command 
nohup ./startNodeManager.sh &. 

5. Start Weblogic Managed Server(bi_server1). 
a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup). 
b. Under Environment, click Servers link. 

                                           
 

The bi_server1 line should show as shutdown state at this point. 

 
 

c.  Click Control tab. 

                                    
 

d. Select the bi_server1 line by clicking on the left tick box. 
e. Click Start button at the top of the list and confirm starting this service. 
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f. State will update to “RUNNING” mode after a few minutes.  
 

6. Start OBIEE services and login  
a. Starting services From EM screen  

i. Login to the EM administration screen using the URL: 
http://localhost:7001/em (Replace the hostname and port number 
based on your setup). Use the login you created in BIEE installation 
to log in. 

ii. Expand 'Business Intelligence' node on the left and choose 
Coreapplication.  
 

                                     
 

iii. Click Overview Tab. 
 

              
 

iv. Click Restart (or Start) under the Manage System section. 
v. Click Yes on dialog box to confirm the move. Wait for message that 

confirms successful restart. 
b. If starting using EM is not successful and complaining about OPMNCTL not 

up, follow starting process with OPMNCTL. 
i. Open a command prompt, navigate to <Oracle BI Instance 

Home>/bin. 

37 
 



 

ii. Run ./opmnctl status, this will show you status of all the OBIEE core 
services  

iii. run ./opmnctl startall or ./opmnctl stopall depending on your need. 
7. Deploy RPD and webcat file(s). 

a. Navigate to folder $FIC_HOME/ALMBI/RPD_WEBCATALOG/ which contains 
both ALMBI.rpd and archived ALMBI.catalog (contains the shared folder of 
ALMBI application).Copy both the files to a local folder. 

b. Login to  
I. OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em). 
II. Click on coreapplication from ‘Business Intelligence’ tab on left hand 

side. 
III. Under ‘coreapplication’, select the tab ‘Deployment’ and click ‘Lock and 

Edit Configuration’ button located below title ‘coreapplication’. The below 
screen is displayed. 

 
IV. RPD Deployment: 

1. Select Browse button available under Upload BI Server 
Repository section and select ALMBI.rpd file from the local 
folder. Enter Repository password ‘Administrator1’. 

V. Web catalog Deployment: 
1. Create a new webcatalog folder for ALM BI application through 

Enterprise Manager of OBIEE. 
2. Set the Catalog Location available under ‘BI Presentation 

Catalog’ like: 
“$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServic
esComponent/$COMPONENT_NAME/catalog/ALMBI”. 

3. Click Apply and then click Activate changes. A pop up will be 
shown after successful activation. 
 

 
 

4. Click Close and switch to Capacity management tab. 
5. Restart the presentation services. Under the System 

Components Availability, select Presentation Services and 
click on Restart Selected option. 
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VI. Once the Presentation Service is restarted, it will give the pop up for 
successful restart. Click Close. 

VII. Verify that new folder structure is created in the system. It can be found 
under path : 
 <Oracle BI Instance Home> 
\bifoundation\OracleBIPresentationServicesComponent\coreapplication_
obips1\catalog\ALMBI 

VIII. This ‘ALMBI’ folder will be having a root folder which in turn contains 
three folders named ‘shared’, ‘system’ and ‘users’. 
 

                                      

 
 

c. Open the Catalog Manager 
a. Navigate to File menu and open the catalog online (File->Open catalog) by 

giving the necessary credentials based on your setup (Type - (online), URL - 
(http://<ipaddress>:<port>/analytics/saw.dll). 

b. Once the catalog is opened, it will display a folder structure on left hand side. 
Select the root folder in the LHS tree structure. 

c. Go to ‘File’ menu and select ‘Unarchive’. It will ask for the path for a file. 
d. Browse the path of the archived catalog file saved in your local folder using 

the ‘Browse’ button in the pop up. Click ‘OK’. 
e. The catalog will be unarchived in specified location. A pop up for successful 

operation will be shown. Restart the presentation services once again. 
d. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) Login with 

credentials based on your setup, and verify that catalog is available. 
8. Configure tnsnames.ora. 

a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin. 
b. Make sure an entry is made in the tnsnames.ora to connect to atomic 

schema of OFSAA application. 
c. Save the tnsnames.ora. 

9. Configure ODBC data source to connect to Oracle BI Server. 
a. Go To Control Panel>Administrative Tools>Data Sources (ODBC). 
b. Select the ‘System DSN’ tab and click ‘Add’ Button. 
c. Select a driver specific to (Oracle BI Server 11g) and click ‘Finish’ Button. 
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d. Enter ‘Name’ and ‘Server’ details (Specify the Host Name or IP Address of 
the BI Server and click ‘Next’). 

e. Enter Oracle BI Server login id and password (Enter User Name and 
Password created at the time of OBIEE installation). Click ‘Next’. 

f. Click ‘Finish’. 
10. Modify connection pool and set the properties.  

a. Open the OBI Administration tool. 
b. Select Start > Programs > Oracle Business Intelligence > BI Administration. 
c. Select File > Open > Online and select ‘ALMBI.rpd’ file. 
d. In the Open dialog box, select and open ‘ALMBI.rpd’ file. 
e. Enter Repository password as'Administrator1' 
f. In the "Physical" layer, double-click the Connect Pool: “ALMBI” to open its 

properties. 
g. In the ‘General’ tab, edit / check the following entries: 

• Call Interface: (OCI 10g/11g).  
• Data source name: <tnsnames.ora entry created in the step 8.b 

connecting to OFSAA atomic schema>.  
• User name: <enter atomic db user name>.  
• Password: <enter atomic db user password>.  
• Confirm password and Click 'OK' to close the window and click 'Save' to 

save the RPD file.  
h. Click 'No' for the Global Consistency Message.  
i. Close the RPD file (File / Exit).  

11. Login into OFSALMA Application using the URL: 
http://localhost:9704/analytics.(Replace the port number based on your setup). 
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Trouble shooting 
Problem: After logging into OFSALMA Application, if end user experiences an error as 
“Exceeded configured maximum number of allowed output prompts, sections, rows, or 
columns” while accessing reports. 

Solution:  

1. Bring down OBIEE Presentation services. 
2. Locate and take a back up of the file ’Instanceconfig.xml’ in following folder structure 

<Oracle BI Instance 
Home>\config\OracleBIPresentationServicesComponent\coreapplication_obips1 

3. Edit the file. Locate the tab ‘<view>’ which in turn contains ‘<pivot>’ tab in 
instanceconfig.xml. 

4. Paste the following lines in between ‘<pivot>’ and ‘</pivot>’ tab. 
<MaxVisibleColumns>3000</MaxVisibleColumns> 
<MaxVisiblePages>10000</MaxVisiblePages> 
<MaxVisibleRows>50000</MaxVisibleRows> 
<MaxVisibleSections>250</MaxVisibleSections> 
<DefaultRowsDisplayed>30</DefaultRowsDisplayed> 

5. Save the file and restart the presentation services. 
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OBIEE Installation and Configuration Guide Link  
You can refer to the OBIEE installation and configuration guide from the following location: 

• http://www.oracle.com/technology/documentation/bi_ee.html
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